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General information
About this documentation

1 General information

1.1 About this documentation

The documentation is part of the product and contains important information. The doc-
umentation is for everyone who works with this product.

The documentation must be accessible and legible. Make sure that persons respons-
ible for the system and its operation as well as persons who work independently with
the software and the connected units of SEW-EURODRIVE have read through the
manual carefully and understood it. If you are unclear about any of the information in
this documentation or if you require further information, please contact
SEW-EURODRIVE.

1.2 Content of the documentation

The descriptions in this documentation apply to the current software/firmware version
at the time of publication. When new versions of software/firmware are installed, the
descriptions may differ. In this case, contact SEW-EURODRIVE.

1.3 Product names and trademarks

The brands and product names in this documentation are trademarks or registered
trademarks of their respective titleholders.

1.4 Copyright notice

© 2019 SEW-EURODRIVE. All rights reserved. Unauthorized reproduction, modifica-
tion, distribution or any other use of the whole or any part of this documentation is
strictly prohibited.

1
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Safety notes

Preliminary information

2 Safety notes

21 Preliminary information

The following general safety notes serve the purpose of preventing injury to persons
and damage to property. They primarily apply to the use of products described in this
documentation. If you use additional components, also observe the relevant warning
and safety notes.

2.2 Target group

Any work with the software may only be performed by a specialist with a suitable edu-
cation. A specialist in this context is someone who has the following qualifications:

* Appropriate instruction
* Knowledge of this documentation and other applicable documentation.

+  SEW-EURODRIVE recommends additional training for products that are operated
using this software.

Designated use

The MOVISUITE® engineering software is the operating platform for all MOVI-C® hard-
ware and software components.

Network security and access protection

A bus system makes it possible to adapt electronic drive technology components to
the particulars of the machinery within wide limits. There is a risk that a change of pa-
rameters that cannot be detected externally may result in unexpected but not uncon-
trolled system behavior and may have a negative impact on operational safety, system
availability, or data security.

Ensure that unauthorized access is prevented, especially with respect to Ethernet-
based networked systems and engineering interfaces.

Use IT-specific safety standards to increase access protection to the ports. For a port
overview, refer to the respective technical data of the device in use.

6 Installation Instructions — Installation and Project Adjustment
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Introduction 3

Short designations

3 Introduction

31 Short designations

The following short designations are used in this documentation:

Type designation Short designation
MOVISUITE® standard MOVISUITE®
MOVISUITE® version V2.1.237.0 MOVISUITE® SP10
MOVISUITE® version V2.0.114.100 MOVISUITE® SP9 service pack 1
MOVI-C® CONTROLLER power UHX85A or

MOVI-C® CONTROLLER advanced UHX45A or MOVI-C® CONTROLLER
MOVI-C® CONTROLLER standard UHX25A

3.2 Content of this documentation

The documentation in hand enables you to install the engineering software correctly
and to adjust existing projects to the latest version of MOVISUITE®.

Installation Instructions — Installation and Project Adjustment 7



4 Installation
Before updating the software

4 Installation
4.1 Before updating the software
INFORMATION
i When you update to MOVISUITE® SP10, an existing IEC project can only be used

with MOVI-C® CONTROLLERSs that have a firmware version which is compatible with

MOVISUITE® SP10.

INFORMATION

jde

Changes to MOVI-C® devices may only be made with the matching MOVISUITE® ver-
sion.

For an overview of versions of MOVI-C® devices for MOVISUITE® SP9 service pack 1
and SP10, refer to the chapter "Overview of version numbers" (— B 46).

411 Update required
An update to MOVISUITE® SP10 is required in the following cases:

New functions

You want to use MOVI-C® CONTROLLERs that have been delivered by
SEW-EURODRIVE after calendar week 11, 2019. The firmware state of these
devices must be taken into operation using MOVISUITE® SP10.

You want to use MOVIDRIVE® technology including the MOVIKIT® software
modules Velocity Drive and Positioning Drive.

You want to use the decentralized MOVI-C® device MOVIGEAR® performance
(DFC, DFC-CiA402 or DSI) with the MOVIKIT® software module MOVIKIT® Velo-
city or Positioning Drive.

You want to use the latest generation of CS..A safety cards (firmware state 2.05).

In order to secure the long-term procurement of spare parts, SEW-EURODRIVE
recommends to change firmware state 1.05 of safety cards in existing systems to
firmware state 2.05.

You want to use one of the new functions of the new version.

Online help

For the time being available as a mere online help for first parameters of the stand-
ard parameter tree. The online help will be expanded and updated permanently.
Activation is scheduled for March 23, 2019.

Versioned management of IEC projects

— An IEC project created with SP9 can be opened and edited with MOVISUITE®
SP10. The firmware state and version control of the software modules is
checked when opening the project in SP10. Returning to MOVISUITE® SP9
with the project is basically possible as long as none of the new functions of
SP10 is used when working on the project.

— You can continue to work on an IEC project created with SP9 or a later version
using any later version of MOVISUITE® and its IEC Editor without having to
convert to new libraries.

8 Installation Instructions — Installation and Project Adjustment
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Installation
Before updating the software

«  MOVISUITE® SP10 uses codesys version 3.5 SP13 patch 1. This version supports
the multi-core capability of the controllers of SEW-EURODRIVE and is installed
without user entries (silent installation).

* Assist CS V2 with the following new functions

Expanded parameter tree: Safety functions that are not used are hidden auto-
matically.

The latest firmware 2.05 of the CS..A safety cards is supported. This firmware
supports PROFIsafe v2.4 & v2.6 (EtherCAT®, data container size: v2.4: 14Byte,
v2.6: 28Byte).

Login without reading the safety key ID of the device (auto read out)
Flashing pattern of LED for locating devices

Last entered data are displayed as suggestion when creating a report
Notes regarding deviations from default values are displayed

Default values can be applied to entire pages

Login page is displayed depending on devices

+ CAM Editor with the following new functions

Can either be opened using the button in the toolbar or using the context menu
in the curve explorer.

Standard functions (save, cut, copy, paste) can be performed using shortcuts
Several curves can be displayed one below the other

Curves can be hidden

A curve legend can be displayed

Speed limits and acceleration limits can be shown or hidden

« New MOVIKIT® software modules Velocity and Positioning for MOVI-C®
CONTROLLER with direct fieldbus connection

» |EC Editor with expanded functions

CAN Layer 2 Manager for UHX25 and UHX45
CoE access during runtime

Allows for changing parameters such as reference offset and deceleration
ramps.

EEPROM access

Write and read access to EEPROM for adjusting the slave configuration (e.g.
for valve blocks, 10 link gateways — fixed or variable PDOs).

PDO upload from the device

Easy adjustment of the IEC project for slaves configured with variable PDO
lengths, such as gateways. Process data assignment of the device can be
read.

SEW MOVIKIT® utilities expanded by "ChangelnverterUserUnit", "DeviceAd-
apterOSC71B", and "FileHandler"

4.1.2 No update required

Updating to MOVISUITE® SP10 is not necessarily required in the following cases:

* None of the cases described in chapter "Update required" (— B 8) apply to you.

Installation Instructions — Installation and Project Adjustment
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4 Installation
Requirements

*  You use MOVI-C® CONTROLLERs delivered by SEW-EURODRIVE before calen-
dar week 32, 2018 (MOVISUITE® SP8) and do not want to convert your system to
MOVISUITE® SP10.

* You use axis modules in already existing systems that have been taken into
operation with a MOVISUITE® version V1.1.xxxx.x or V1.2.xxxx.x. Axis modules
that were delivered by SEW-EURODRIVE after calendar week 32, 2018 can be
used without having to adjust their firmware (downward compatibility). However,
you can only use features for your axis modules that are supported by the firm-
ware version of the already existing system.

Refer to the description of the firmware of safety cards in chapter "Update re-
quired" (— B 8).

41.3 Integrating axis modules

Axis modules can only be operated on a MOVI-C® CONTROLLER with the same firm-
ware version or a later one. If the firmware of the axis modules is older than the
MOVI-C® CONTROLLER, you will have to update the firmware of the axis modules.

For support in updating the firmware, contact SEW-EURODRIVE Service.

4.2 Requirements

421 Installation requirements
Before installing MOVISUITE®, observe the following requirements:
* You must have administrator rights for your PC.
« You can install only one MOVISUITE® version on your PC.

Before changing to the latest MOVISUITE® version, read the instructions in
chapter "Before updating the software" (— & 8).

« If a MOVISUITE® version up to V1.1.xxxx.x is installed on your PC, uninstall it.
From version V1.1.xxxx.x, the predecessor version is uninstalled automatically
when installing MOVISUITE®.

4.2.2 Hardware requirements

Processor 1 GHz 32-bit processor (x86) or 64-bit processor

RAM At least 4 GB RAM, recommended are 8 GB RAM

Hard disk 7 GB of free memory in total, 4 GB of that on the operating sys-
tem hard disk for complete installation of MOVISUITE®

Graphics card 2 GB graphics memory

Resolution The default resolution is full HD resolution. A resolution of

1280 x 800 is appropriate.

1 O Installation Instructions — Installation and Project Adjustment
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4.2.3

4.3

4.31

Installation
Installing the software

Requirements on the operating system

Operating system

MOVISUITE® is a 32-bit application.

The following operating system variants are permitted:
*  Windows 7 at least SP1 32-bit/64-bit

*  Windows 8.1 32-bit/64-bit

*  Windows 10 32-bit/64-bit

Redistributables

The following Microsoft components must also be installed:
* Microsoft Windows Installer 3.1 or higher
*  Microsoft. NET Framework 4.6

Installing the software

INFORMATION

i The installation will only be performed if the IEC Editor version of the installation
package (version V3.5.13.1) is not installed on your PC.
INFORMATION

i If you have already installed MOVISUITE® on your PC and you have worked with

MOVISUITE® or the IEC Editor after having started your PC last time, then start your

PC again before installing a new MOVISUITE® version.

MOVISUITE® is installed in several steps:
* "Preparing the installation" (— & 11)

» "Performing the installation" (— B 13)

Preparing the installation

1. Copy the following installation files to the hard disk of your PC: movi-
suite.syspkg, MOVISUITE-Licence.txt, MovisuiteSetup.exe.

Installation Instructions — Installation and Project Adjustment
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4 Installation
Installing the software

2. If the installation files are available on a write protected medium (e.g. on a DVD),
then remove the write protection from all 3 installation files. To do so, open the
context menu with a right mouse-click and open the properties of the files.

3. On the "General" tab, disable the "Read only" check box.

.+ MovisuiteSetup.exe, ... Properties @
General | Details

” 3 Files, 0 Folders

Type: Multiple Types
Location: Allin C:\1_inst\SEW\SPO10-B7. 3\MOVISUITESetup
Size: 2,09 GB (2.247.496.516 bytes)

Size on disk: 2,09 GE (2.247.495. 775 bytes)

Attributes | [T]Hez
[ Hidden

[ OK. J [ Cancel Apply

18014422019228043

1 2 Installation Instructions — Installation and Project Adjustment
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Installation 4
Installing the software

4.3.2 Performing the installation

1. Run the "MovisuiteSetup.exe installation file "with administrator rights. To do
s0, right-click the file to open the context menu and select [Run as administrator].

-~

MName Date modified Type Size
| movisuite.syspkg 27.02.2019 16:33 SYSPKG File 2.188.964 KB
| MOVISUITE-Licence txt 27.02.201916:32 Text Document 16 KB
| 8 MovisuiteSetup.ex e — 5.843 KB |
Open

Run az administrator

&

Troubleshoot compatibility
Scan for threats...

Add te archive...
Add te "MovisuiteSetup.rar”

Compress and email...

i (660 i i <

Compress to "MovisuiteSetup.rar” and email

Restore previous versions

Send to r
Cut

Copy

Create shortcut
Delete

Rename

Properties

9007222765267467
= The software is installed using a wizard.

2. If you are requested to reboot your PC when installing the IEC Editor, it is import-
ant that you follow this instruction.

INFORMATION

If you do not reboot your PC, an error will occur when installing the IEC packages.
This error can only be eliminated by restarting the PC and installing MOVISUITE®
again.

jde

= After having rebooted the PC, the wizard continues installing MOVISUITE®.

4.3.3 Installation failed

In rare cases, virus scanners or firewalls can cause problems when installing
MOVISUITE®. In this case, refer to the log files of the virus scanner or the firewall for
information on possible problems.

Installation Instructions — Installation and Project Adjustment 1 3



5 Adjusting an existing MOVISUITE® project

5 Adjusting an existing MOVISUITE® project

Adjusting an existing MOVISUITE® project is explained in more detail by way of the
following 2 examples:

"Converting only the engineering software to SP10" (— E 15)

The engineering tasks are performed using MOVISUITE® SP10. However, the follow-
ing hardware and software components should keep the version state of
MOVISUITE® SP9 service pack 1:

+  Firmware of the MOVI-C® CONTROLLERSs
» Firmware of the safety cards

* Al IEC libraries

« Al MOVIKIT® software modules

"Converting all components to SP10" (— & 17)

The engineering tasks are performed using MOVISUITE® SP10. All hardware and
software components are also converted to the version state of MOVISUITE® SP10.

In the example, the following device topology is used for both cases:
+  MOVI-C® CONTROLLER power UHX85A

+  MOVIDRIVE® modular application inverter, MDD90A double-axis module. The
MOVIKIT® MultiMotion software module is assigned to the first axis.

+  MOVIDRIVE® modular application inverter, MDA90A single-axis module with
MOVISAFE® CSS21A safety card and assigned MOVIKIT® MultiMotion Camming
software module.

An IEC project already exists. A data backup of the existing project, created with
MOVISUITE® SP9 service pack 1, is available.

1 4 Installation Instructions — Installation and Project Adjustment
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Adjusting an existing MOVISUITE® project 5

Converting only the engineering software to SP10

The following figure shows the device topology of the existing project:

hR R 020 02020w
Meues Projekt SPS Plann ing

{1} Scan 10 Configure communication

SP9 Project » Axis3 — C2

5.1

? MNeues Projekt SPS

9007224510620939

Converting only the engineering software to SP10

In this case, the firmware of MOVISUITE® SP9 service pack 1 remains installed on the
MOVI-C® CONTROLLER power UHX85A, the lower-level axis modules, and the
safety cards. Also the IEC libraries and the MOVIKIT® software modules remain at the
version state of MOVISUITE® SP9 service pack 1.

For an overview of versions of MOVI-C® devices for the two MOVISUITE® versions,
refer to the chapter "Overview of version numbers" (— & 46).

Proceed as follows:
1. Install MOVISUITE® SP10 on the engineering PC.

= MOVISUITE® SP9 service pack 1 will be uninstalled automatically when in-
stalling SP10.

2. Open the project that has been created with MOVISUITE® SP9 service pack 1.

Installation Instructions — Installation and Project Adjustment 1 5



5 Adjusting an existing MOVISUITE® project

Converting only the engineering software to SP10

3. Open the IEC Editor project.
= The "Project Environment" window opens.

Library versions | Compiler version | Visualization profile |
For the following libraries currently in use, newer versions are available:
Library Current FRecommended  Action
SEW MOVIKIT MultiMotion (SEW-ELRODRIVE) 2.0,200.0 2,4.13,200 Do not update
SEW MOVIKIT MultiMotionCamming (SEW-ELIRODRIVE) 2.0,200.0 2,3.28.200 Do not update
< | i | N
If thereis a newerversion installed forany of the libraries in this project, it will be listed above. You may
chooseto updatethese libraries by double-clicking in the column ‘Action’.

Check for updates when loading this project

(St v o

28380324747

4. Do not update them as the IEC libraries are to remain at version state
MOVISUITE® SP9 service pack 1.

5. Click [OK].
= The functions compile, save, start, and login in the IEC Editor work properly.
6. Create a boot project.

= The |IEC Editor project is saved on the SD memory card of
MOVI-C® CONTROLLER power UHX85A and is still present after restart.

Save the project in the IEC Editor.
Close the IEC Editor.

1 6 Installation Instructions — Installation and Project Adjustment
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Adjusting an existing MOVISUITE® project 5

Converting all components to SP10

5.2 Converting all components to SP10

1.

2.

E Neues Projekt SPS

SP9 Project » Axis3 — C2

Install MOVISUITE® SP10 on the engineering PC.

= MOVISUITE® SP9 service pack 1 will be uninstalled automatically when in-
stalling SP10.

Open the project that has been created with MOVISUITE® SP9 service pack 1.
= The following figure shows the device topology of the existing project.

hR R 020 02020w
Planning

{1} Scan 10 Configure communication

MNeues Projekt SPS

Axis3

9007224510620939

5.21 Saving the parameter setting of the safety card

1.

Right click to open the context menu of the axis with the integrated safety card.

Installation Instructions — Installation and Project Adjustment 1 7



5 Adjusting an existing MOVISUITE® project

Converting all components to SP10

2. Start the "Assist CS.." tool.

.
Planning

{} Scan 10 Configure communication

@ MNeues Projekt SP9

5P8 Project

. Network

Open configuration

(

Open configuration as window

Toals Compare
Configuration
Manual mode
Scope
[%] Assist CS..

£37 Add from catalog

28388740875

3. Enter the safety key ID and the password.

1 8 Installation Instructions — Installation and Project Adjustment
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Adjusting an existing MOVISUITE® project
Converting all components to SP10

4. Click the [Log in and continue] button.

%] Assist CS.. _ O

SP9 Project > Axis3 — C2

Test mode inactive

1 Parameter setting Create report E Confirm data set

Device login

Enter the safety key 1D of the device to verify
the identity of the device.

Safety key ID

b700 001a 79a2 2c2d hex

Enter your password to confirm permission for
setting parameters.

Ty =3

Password

wend]

[ Log in and continue ]

28388745483
5. Click the red tab "Assist CS..".

%] Assist CS.. _d

SPY_Project » Axis3 — C2 Test mode active Test mode inactive

1 v Parameter setting Create report E Confirm data set

491 Checksum overview

=
28535023627
= The main menu of the "Assist CS.." tool is displayed.

5
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5 Adjusting an existing MOVISUITE® project

Converting all components to SP10

6. Click [Export].

F i F"

- : () ( D
Assist CS.. = ~ U,
= > Projects Archive Password Program

information

Project

Archive
Open report from archive

Password

Change password

Update

o]

28535028235

= The export window opens.

Installation Instructions — Installation and Project Adjustment
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Adjusting an existing MOVISUITE® project 5

Converting all components to SP10

Assist CS..

Archive Password
information

Projects

Export...

Export path
| CACS521A.ds2xExport -

Cancel

28389850891

7. Click the [...] button.
8. Select the export path.
9. Click [Export].

= The data set is written to the storage location you have specified in the export
path.

10. Confirm the message that export is completed.

= You have successfully exported the parameter setting to the safety card. To re-
store the parameter setting, you can use the export file.

5.2.2 Firmware update of the MOVI-C® CONTROLLER

Exporting a firmware image
Click the red "MOVISUITE®" tab.
2. Under "New project", click [Planning].
= A new, empty project is created in MOVISUITE®.
3. Add the required MOVI-C® CONTROLLER.

Installation Instructions — Installation and Project Adjustment 2 1



5 Adjusting an existing MOVISUITE® project

Converting all components to SP10

4. Select the latest version of the controller from the catalog.

= UHX45A

MOVI-C®
CONTROLLER
advanced

‘ UHXE5A
:

MOVI-C®
CONTROLLER
progressive

SoftwareNode

A

CONTROLLER
Internal
Device properties

=

Functions

ff Data management
Diagnostics

P Status
Licensing
MOVIRUN ® flexible

Ell IEC project

2

UHX45A

MOVI-C® CONTROLLER advanced

Module type
UHX45A

Version

-]
03.57 E W

03.57 s

02.00

None =

— NACwv.NNIS_SE2.A_NNA

28535045643

o

From the menu, select [Functions] > [Data management] > [Export firmware].

Export firmware

vort the firmware image to the selected

folder.

Device replacement

Export firmware

28535048587

6. Click [Firmware export].
= The "Search folder" window opens.
7. Select a target folder.
8. Click [OK].
\daﬁee
! FSzip
28535053963

= You find the ZIP file "FS.zip" in the export directory.

22 Installation Instructions — Installation and Project Adjustment
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Adjusting an existing MOVISUITE® project 5

Converting all components to SP10

Copying the firmware image to the memory card

INFORMATION

Keep the existing image on the memory card to obtain the settings for automatic
device replacement and the license information.

fde

v" The controller replacement function is enabled. For further information, refer to the
chapter "Controller replacement function" (— & 45).

Switch off the MOVI-C® CONTROLLER.

Remove the memory card from the MOVI-C® CONTROLLER .
Insert the memory card into a memory card reader.

Copy the exported firmware image (— B 21) onto the memory card.
Insert the memory card into the MOVI-C® CONTROLLER.

Switch on the MOVI-C® CONTROLLER.

= You can now see on the controller node in the project that the version has
changed.

7. Click the [Device — PC] button.

Controller Controller Copy
‘@ 2

o a0~ o0 bhd =

Awis Axis2

Lo A

2 notifications for

A Different device versions detected

e Data set different

Possible causes and solutions:

Data set in device does not match data set saved in project.

P PC — device 2b Device — PC X Close

28535102091

= You have now successfully updated the firmware.

5.2.3 Updating the inverter firmware

For an overview of versions of MOVI- C® devices for the two MOVISUITE® versions,
refer to the chapter "Overview of version numbers" (— E 46).

Installation Instructions — Installation and Project Adjustment 23
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Adjusting an existing MOVISUITE® project
Converting all components to SP10

Controller

Axis2

g3 g

©

5.24 Updating

To have the firmware of an inverter updated, contact SEW-EURODRIVE Service.

v The MOVI-C® CONTROLLER and the lower-level axis modules have the firmware
state of SP10.

v" The MOVISAFE?® safety cards have the firmware state of SP10.

v" You have adopted the safety keys during replacement of the MOVISAFE® safety
cards.

1. Click the yellow warning sign at the node of an inverter.
= The notification window of the inverter opens.

Controller Copy

i

2 notifications for

A Different device versions detected

e Data set different

Possible causes and solutions:

Data set in device does not match data set saved in project.

P8 PC — device 2b Device — PC X Close

28535102091
2. Click the [Device — PC] button.

MOVIKIT® software modules

An automatic update function is not available for MOVIKIT® software modules. This
means you have to update the MOVIKIT® software modules manually.

24 Installation Instructions — Installation and Project Adjustment
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MultiMotion

Copying controller nodes
1.

Adjusting an existing MOVISUITE® project 5

Converting all components to SP10

Copy the controller node by selecting [Copy] from the context menu.

@ MovIsuITE® ES  spoProject SP10 Planning

Q) Scan & Configure communication

-+ K| ¥ = @ > Controller A

2.

Open configuration

(Q“: [Z] Open configuration as window

Tools
0 Add structure node

% Add from catalog
contpoic & 9
2. Rename
K Cut
Eg Ccopy
3

© Delete
) Reset device fault
/ Activate configuration state

_ & Update IEC project

5 Update configuration data

28535185035

Insert a copy of the controller node on the project node by selecting [Paste] from
the context menu.

@ MoVISUITE® ES  spoProject sP10 Planning

-+ KX

3 Add from catalog
(8 Paste
8 Pastey,
Clear function view
) Resetall device faults

C - all devices
> All devices — PC

(* New project

4> Open project
= save project
Bl save project as.
<M Import project
1 Export project

28535187467
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Updating software modules

1. Click the software module and select [Add from catalog] from the context menu.

5P%Project_SP10

Open configuration
'] Open configuration as window

E" Add from catalog S

I Delete

él'él Copy data

2. Click the MOVIKIT® software module type.
3. Select version 2.4.13.200.

26 Installation Instructions — Installation and Project Adjustment
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4. Click [Apply].

@ MovISUITE® ®  Proje..SPI0 Planning

{3 scan I Configure communication | §=

— 4t h B — Network

Catalog Projekt SP9_zu_SP10

SEW-EURODRIVE > Products > Software

By name 5] %l [ Apply product

MOVIKIT® Positioning Drive
Velocty Drve
Search m
Drive
Device type e

MultiAxisController MultiMotion Camming
MultiMotion Positioning

MultiMotion

Module group =

Drive Motion ‘

Module type =

flex

MOVIKIT® MuktiMotion

Module type
MultiMetion

Version

2.413.200

[

More filters =

28535987595
5. Repeat this step for all software modules.

= You have now successfully updated the software modules to the latest version.

Comparing and adjusting settings

Some settings are reset to the factory setting when updating the software modules.
You therefore have to set them to the required value again by means of a comparison.
To do so, perform the steps in the sections "Comparing settings" (— B 27) and "Ad-
justing settings" (— B 29) for all devices in the software module.

Comparing settings
1. Click the "Planning" tab.

Planning Startup

40 Configure communication

28536311051
= MOVISUITE® changes to the "Planning " work phase.
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2. On the device (for example "Axis1"), select [Tools] > [Compare] from the context

menu.

Q)

Controller

Ags2 Axis3
P Py

Open configuration
Open configuration as window
Tools

Add from catalog

" Rename
Cut
Copy
Delete

Copy data

SP9Project_SP10

Cont}ril‘ljicopy

2

/| AppServiceTestPlugin
Startup wizard
Compare
Configuration

Data Flexibility Editor
Firmware loader

=N

Al

)
%,
(=]
)

7
M

C

Manual mode
Monitor
Parameter tree

Scope

XML-ParameterExchange
28536315659

= MOVISUITE® opens the "Compare" screen.
3. Click [Device data] > [Device identification] > [Add device].

Compare
b4 Comp

@ > Controller A > Axis1

Device properties 2.1.1 Device identification

B Device data Name

Basic settings 4 Customer-specific device

data

Drive trains Device designation Axis1

Internal parameters
DT

Internal parameters
DT2

Functions

‘E» Inputs/outputs Device identification
Setpoints
ctual values
rive functions
echnology functions

Monitoring functions

Diagnostics

MOVIKIT® MultiMotion

28 Installation Instructions — Installation and Project Adjustment

— 0O

@ Add device | 2 Refresh data | % Editable values only | % Only differences

Axis1

©
Add device

®

Add offline device

28536318091
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Compare

> Controller A > Axisl

Device properties

B Device data

Basic settings

Drive trains

E@ Internal parameters
DT

I}@ nternal parameters
D12

Functions

"EL Inputs/outputs

E Setpoints
Actual values

Drive functions

Technology functions

Monitoring functions
Diagnostics

MOVIKIT® MultiMotion

Device identification

Compare

@ > controller A > Axis1

Device properties
B Device data
p——
Drive trains
Internal parameters
DT1

Internal parameters
DT2

Functions
kNl Inputs/outputs
Setpoints
E=8 Actual values
rive functions
fechnology functions
Monitoring functions

Diagnostics
MOVIKIT® MultiMotion

Adjusting an existing MOVISUITE® project 5
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4. As the item to be compared, select the device underneath the copied controller
node that corresponds to the first device.

— 0O

@ Add device | 2 Refresh data | % Editable values only | % Only differences

2.1.1 Device identification

Name Axis1
4 Customer-specific device
data

Device designation Axis1

©
Add device

2]

Add offline device

Device identification

28536320523

= Sections with differences are indicated with red background in MOVISUITE®.

— 8 >

@ Add device | T Refresh data %+ Editable values only | # Only differences

2.1.1 Device identification

Name Axis1 Axis1

4 Customer-specific device
data

Device designation Axis1 Axis1

(+]
Add device

28536322955

Adjusting settings
Perform the following steps for each section in which differences have been identified.
1. Click on the section.

2. Click on a parameter with differences.
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3. In the right column of the comparison view, select [Apply value for...] from the con-
text menu.

4 1.1 Basic unit

Name Axis1 AxisT
4 Bigital inputs
“ Function
_ Keine Funktion [E] FCB 12 Reference travel [E]
DI 02 Keine Funktion h Apply value for..
Dl 03 Keine Funktion [E] Keine Funktion =l
DI 04 Keine Funktion [E] Keine Funktion El

28536325387

4. Click on the name of the device for which you want to apply the value.

4.1.1 Basic unit
Name Axis1 Axis1
- Bigital inputs
4 gunction
Bi o1 FCB 12 Reference travel ~ [E] FCB 12 Reference travel EI)
DI 02 Keine Funktion =] Keine Funktion =]
DI 03 Keine Funktion [E] Keine Funktion =

28536327819

= Device and software module now reflect the latest state.

Saving settings
To complete the update, write the modified settings into the devices.
1. To do so, click the "Startup” tab.
= MOVISUITE® changes to the "Startup" work phase.

AR 0000 00s
Planning

C) Scan 40+ Configure communication

28536332683
= The device nodes indicate differences in the data sets.
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Controller Copy

2 notifications for "Axis1"

A Different device versions detected

e Data set different

Possible causes and solutions:

Data set in device does not match data set saved in project.

P8 PC — device 2b Device — PC

28536335115
2. Click the [Device — PC] button.

Controller

|

Axis3

2 notifications for "Axis1"
A Different device versions detected

e Data set different

Possible causes and solutions:

Data set in device does not match data set saved in project.

PE PC — device 2b Device — PC

28535102091

3. Perform these steps for all devices whose device nodes indicate a difference.

25973479/EN — 03/2019

= The project is now up to date.
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MOVIKIT Robotics

First, perform the steps described in the chapters "Copying controller nodes" (— B 25)
and "Updating software modules" (— B 26).

Setting the kinematic model

1. In the copied controller node, open the parameter [Kinematic Model] > [Model Se-
lection].

2. Check the value for "Model".

3. In the original controller node, open the parameter [Kinematic Model] > [Model Se-
lection].

Device properties Model Selection

Device data

Robotics Kinematic Model

Model
Kinematic Model TRIPOD_RRR_M10 5
C Path Emergency
Dynamics :
R e el For details about the kinematics models see
CE"ES'E" LIl TRIPOD_RRR_M10: KinPar the documentation of MOVIKIT Robotics.

Transformations TRIPOD_RRR_M10: Joints

Ny Axis-Joint

adll Transformaticns

Module identification

28536594315
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4. Check the value for "Model". If the value for "Model" differs from that in the copied
controller node, select it accordingly.

5. On the device (for example "Axis1"), select [Tools] > [Compare] from the context
menu.

UHX6! flAC opy
’ ""-‘.Ell

TripodSP9

Open configuration
Open configuration as window
Tools ] Compaﬁ

Configuration
T* Add structure node & =

|_
* A Add from catalog 3_uu i

# Rename

28536345483

Comparing and adjusting settings

Some settings are reset to the factory setting when updating the software modules.
You therefore have to set them to the required value again by means of a comparison.
To do so, perform the steps in the sections "Comparing settings" (— B 33) and "Ad-
justing settings" (— B 35) for all devices in the software module.

Comparing settings
1. Click the "Planning" tab.

Planning Startup

40~ Configure communication

28536311051
= MOVISUITE® changes to the "Planning " work phase.

Installation Instructions — Installation and Project Adjustment 33



5 Adjusting an existing MOVISUITE® project

Converting all components to SP10

2. On the device (for example "Axis1"), select [Tools] > [Compare] from the context

menu.

Q)

Controller

Ags2 Axis3
P Py

Open configuration
Open configuration as window
Tools

Add from catalog

" Rename
Cut
Copy
Delete

Copy data

SP9Project_SP10

Cont}ril‘ljicopy

2

/| AppServiceTestPlugin
Startup wizard
Compare
Configuration

Data Flexibility Editor
Firmware loader

=N

Al

)
%,
(=]
)

7
M

C

Manual mode
Monitor
Parameter tree

Scope

XML-ParameterExchange
28536315659

= MOVISUITE® opens the "Compare" screen.
3. Click [Device data] > [Device identification] > [Add device].

Compare
b4 Comp

@ > Controller A > Axis1

Device properties 2.1.1 Device identification

B Device data Name

Basic settings 4 Customer-specific device

data

Drive trains Device designation Axis1

Internal parameters
DT

Internal parameters
DT2

Functions

‘E» Inputs/outputs Device identification
Setpoints
ctual values
rive functions
echnology functions

Monitoring functions

Diagnostics

MOVIKIT® MultiMotion
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— 0O

@ Add device | 2 Refresh data | % Editable values only | % Only differences

Axis1

©
Add device

®

Add offline device

28536318091
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Compare

> Controller A > Axisl

Device properties

B Device data

Basic settings

Drive trains

E@ Internal parameters
DT

I}@ nternal parameters
D12

Functions

"EL Inputs/outputs

E Setpoints
Actual values

Drive functions

Technology functions

Monitoring functions
Diagnostics

MOVIKIT® MultiMotion

Device identification

Compare

@ > controller A > Axis1

Device properties
B Device data
p——
Drive trains
Internal parameters
DT1

Internal parameters
DT2

Functions
kNl Inputs/outputs
Setpoints
E=8 Actual values
rive functions
fechnology functions
Monitoring functions

Diagnostics
MOVIKIT® MultiMotion

Adjusting an existing MOVISUITE® project 5
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4. As the item to be compared, select the device underneath the copied controller
node that corresponds to the first device.

— 0O

@ Add device | 2 Refresh data | % Editable values only | % Only differences

2.1.1 Device identification

Name Axis1
4 Customer-specific device
data

Device designation Axis1

©
Add device

2]

Add offline device

Device identification

28536320523

= Sections with differences are indicated with red background in MOVISUITE®.

— 8 >

@ Add device | T Refresh data %+ Editable values only | # Only differences

2.1.1 Device identification

Name Axis1 Axis1

4 Customer-specific device
data

Device designation Axis1 Axis1

(+]
Add device

28536322955

Adjusting settings
Perform the following steps for each section in which differences have been identified.
1. Click on the section.

2. Click on a parameter with differences.

Installation Instructions — Installation and Project Adjustment 35



5

36

Adjusting an existing MOVISUITE® project
Converting all components to SP10

3. In the right column of the comparison view, select [Apply value for...] from the con-
text menu.

4 1.1 Basic unit

Name Axis1 AxisT
4 Bigital inputs
“ Function
_ Keine Funktion [E] FCB 12 Reference travel [E]
DI 02 Keine Funktion h Apply value for..
Dl 03 Keine Funktion [E] Keine Funktion =l
DI 04 Keine Funktion [E] Keine Funktion El

28536325387

4. Click on the name of the device for which you want to apply the value.

4.1.1 Basic unit
Name Axis1 Axis1
- Bigital inputs
4 gunction
Bi o1 FCB 12 Reference travel ~ [E] FCB 12 Reference travel EI)
DI 02 Keine Funktion =] Keine Funktion =]
DI 03 Keine Funktion [E] Keine Funktion =

28536327819

= Device and software module now reflect the latest state.

Saving settings
To complete the update, write the modified settings into the devices.
1. To do so, click the "Startup” tab.
= MOVISUITE® changes to the "Startup" work phase.

AR 0000 00s
Planning

C) Scan 40+ Configure communication

28536332683
= The device nodes indicate differences in the data sets.
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Controller Copy

2 notifications for "Axis1"

A Different device versions detected

e Data set different

Possible causes and solutions:

Data set in device does not match data set saved in project.

P8 PC — device 2b Device — PC

28536335115
2. Click the [Device — PC] button.

Controller

|

Axis3

2 notifications for "Axis1"
A Different device versions detected

e Data set different

Possible causes and solutions:

Data set in device does not match data set saved in project.

PE PC — device 2b Device — PC

28535102091

3. Perform these steps for all devices whose device nodes indicate a difference.

25973479/EN — 03/2019

= The project is now up to date.

Installation Instructions — Installation and Project Adjustment 37




Adjusting an existing MOVISUITE® project
Converting all components to SP10

MOVIKIT MultiAxisController

First, perform the steps described in the chapters "Copying controller nodes" (— B 25)
and "Updating software modules" (— B 26).

Comparing and adjusting settings

Some settings are reset to the factory setting when updating the software modules.
You therefore have to set them to the required value again by means of a comparison.
Perform the following steps for all software modules.

1. Click the "Planning" tab.

Planning Startup

40 Configure communication

28536311051
= MOVISUITE® changes to the "Planning " work phase.

2. On the original software module, select [Open configuration as window] from the
context menu.

3. On the copied software module, select [Open configuration as window] from the
context menu.

4. Arrange the two configuration windows next to one another.

[# configuration X [Z] configuration

@ > Controller A > ASide @ > Controller A > ASide Copy

Device properties MultiAxisController — control function Device properties MultiAxisController — control function

MOVIKIT® Operating mode setting MOVIKIT® Operating mode setting
MultiAxisController EIE MultiAxisController VELLE

P casic settings Priority of compensation Torque o [ Priority of compensation Skew
P gain 30.153498 1/c = 100 < |CH NN Pgain 46.98400
Monitoring functions Sip limiter Active Menitering functions Skew error window 0.000 mm
Drive functions Minimurm/maximum slip speed 1218.75000 = 12187500 mm} rive funcio Encader source for skew compensation Motor encoders
Speed source for calculating overload guard Motor encoders
il Advanced settings Comm‘y et e T e e et e i Active
ul M”':’ Al’“fc ‘;""’"”’ Vel | M“"‘ ‘AI’“'SC‘Z'"U"E’ - Limit acceleration of skew compensation Active
control function control function
i 321690.00000
o T tant 0.0006523173 [ © E
M KpTorquelevelingDefault Il 39.153498 1/s Minimum/maximum compensation speed X

B m e B m

Mndule identification . Module identification

1

2is1

Asis?

Auis group member 3 1

Auis group member 4 1

Torque between axis group members
&

Wert
s &  Mis2 0 % nominal motor torque
ois2 &  Axisgroup member3 0 % nominal motor torque

Avisgroup member3 & Aisgroup member 4 0 % nominal motor torque

Avisgroup member 4 & Avisl 0 % nominal motor torque

28536347915

5. Transfer the configuration values from the copied software module to the original
software module.
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5.2.5 Restoring the parameter setting of the safety card

1. Right click to open the context menu of the axis with the integrated safety card.
2. Start the "Assist CS.." tool.

.
Planning

) sean T Configure communication & & | W ER

b Network

@ MNeues Projekt SP9

SPO_Project

3 Open configuration
¢ Open configuration as window
Tools
Configuration
| Manual mode
# Rename Scope
[%] Assist CS..

QE? Add from catalog

28388740875
3. Enter the safety key ID and the password.
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4. Click the [Log in and continue] button.

%] Assist CS.. _ O

':E » SP9_Project > Axis3 — C2 Test mode inactive

1 Parameter setting Create report E Confirm data set

Device login

Enter the safety key 1D of the device to verify
the identity of the device.

Safety key ID

b700 001a 79a2 2c2d hex

Enter your password to confirm permission for
setting parameters.

Password

wend]

[ Log in and continue ]

28388745483
5. Click the red tab "Assist CS..".

%] Assist CS.. _d

> SP9_Project > Axis3 — C2 Test mode active  Test mode inactive

1 v Parameter setting Create report E Confirm data set

491 Checksum overview

=
28535023627

= The main menu of the "Assist CS.." tool is displayed.

Click the [Import] button.

Select the import file.

Confirm the message indicating that import is completed.

© ® N o

Click [Transfer data to device and continue with "Create report"].

= A window opens with a warning of the turning motor.
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10. If you are sure that the motor cannot turn or that a turning motor does not pose
any risk, then click [Yes].

= A window opens indicating that the parameters have been transferred success-
fully.

11. Next click [Continue with report creation].
12. Close the "Asisst CS.." tool.
= MOVISUITE® signals a fault of the axis with the new safety card.
13. To acknowledge the signaled fault, reset the voltage of the axis module.

= You have now successfully taken into operation the new safety card with the para-
meters of the replaced card.

INFORMATION

The ParCrcBus has changed. Adjust it in the program of the higher-level safety con-
troller.

fde

5.2.6 Updating the IEC project
1. Click on the yellow warning symbol on the node of the IEC project.
= The notification window of the IEC project opens.
A 2 2 20 .
Planning
t} Scan {0 Configure communication ":‘“ %

th Network

(@) Projekt SP9_zu_SP10

5P9_Project

A Configuration state active

a IEC project update required

Possible causes and solutions:

The project structure under the MOVI-C® CONTROLLER has changed. You have to update the __
IEC project. =

A Different configuration data

¥, Update IEC project

28545068555
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2. Click the [Update IEC project] button.
= The "Project environment" window opens.

-
Project Environment u
Library versions | Compiler version | Visualization profile
For the following libraries currently in use, newer versions are available:
Library Current Recommended  Acticn
SEW MOVIKIT MultMotion (SEW-ELURODRIVE) 2.0,200.0 2.4.13,200 Do not update
SEW MOVIKIT MultiMotionCamming (SEW-EURODRIVE) 2.0.200.0 2.3.28.200 Do not update
1 i | 3
i If thereis a newer version installed for any of the libraries in this project, it will be listed above. You may
| chooseto updatethese libraries by double-clicking inthe column 'Action’.
I

H Check forupdates when loading this project

[

—_—— F———— z y
28545071755

3. Click the [Set all to newest] button.

= A confirmation window opens.

Library versions
SEW MOVIKIT MultiMotion (SEW-EURODRIVE): 2.0.200.0 -= 2.4.13.200
SEW MOVIKIT MultiMotionCamming (SEW-EURODRIVE): 2.0.200.0 -=»
2.3.28.200

Compiler version
3.51230-» 351310

Visualization profile |
CODESYS V3.5 5P12 Patch 5 -= CODESYS V3.5 5P13 i
oK
28545194123
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4. Click [OK].
= The "Project environment" window opens.

Project Environment @

Library versions | Compiler version | Visualization profile

For the following libraries currently in use, newer versions are available:

Library Current Recommended  Action
SEW MOVIKIT MultiMotion (SEW-EURODRIVE) 2.0.200.0 2.4.13.200 Update to 2.4.13.200
SEW MOVIKIT MultiMotionCamming (SEW-EURODRIVE)  2.0,200.0 2.3,28.200 Update to 2,3.28.200

4 | m | 3

If thereis a newerversion installed for any of the libraries in this project, it will be listed above. You may
chooseto update these libraries by double-clicking inthe column 'Action’,

Check forupdates when loading this project

-

9007227635065739
5. Click [OK].
= A dialog prompting you to update the storage format opens.
IEC-Editor % ]

% Doyouwant to upgrade the storage format for this project?

- If you click Yes, all changes in your project can be saved without any
loss of data, However, you will not be able te cpen this project with
'SEW 3.512.3 (V5)' any more,

- If you click Ne, you will remain compatible with 'SEW 3.5.12.3 (V5)".
However, not all changes might be stored in the project. Please refer to
the message view for further details.

- If you click Cancel, the operation which caused the storage format
upgrade will be undene.

In either case, the project file stered on disk will not be affected until
you save the project the next time,

[ Ja l[ Mein l [ Abbrechen

b r

28545199371

6. Click the [Yes] button.
= The functions compile, save, start, and login in the IEC Editor work properly.

= After login, the components are displayed without errors.
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=1 PLC Logic [=] »
- 1> Application [run]
=) SEW_Generated 1
= [E.'_I Internal
@ sEw_cvL_Internal
= SEW_PRG (PRG)
[E2 Highprio
[Z2 Hmi
B it
Eﬁ LinkInterfaces
@; LowestPrio
Eﬁ Main
@ sEw o
= user_aApplication
=-[E] user_PRG (PRG)
[Z2 Highpria
B it
Eﬁ Main
@; Readactualvalues
Eﬁ WriteSetpointvalues
m Library Manager
B2 symbol Configuration
= @ Task Configuration
= Qfﬁs TaskHighPrio
& sew_PRG.HighPrio
= Qfﬁs TaskHrmi
) sEW_PRG.Hmi
= Qfﬁs TaskLowestPrio
=&

m

) sEw_PRG.LowestPrio
TaskMain
& sEw_PRG.Main
= [l sEwLogicalDevicePool (SEWLogicalDevicePoal)
(=) LogicalDevice_Axis1 (SEWLogicalDeviceInterpolationFlexFull)
@ LogicalDevice_Axis2 (LogicalDeviceQEM)
(=) LogicalDevice_Axis3 (SEWLogicalDeviceInterpolationFlexFull)
=75l EtherCAT (LANZ)
& SBUS_PLUS1 (EtherCAT MasterSEW)
= I Dev_Axis1_Awxis2 (MOWI-C MOVIDRIVE Double Axis)
H". Axis1 (InterpolationFlexFull)
: <leerl:>
M¥% Axis2 (15 PD)
: <leerl>
= I Dev_Axis3 (MOVI-C MOVIDRIVE Single Axis)
H". Axis3 (InterpolationFlexFull)
'ﬁj Axis35afety (Failsafe Container Profisafe 6/5 Byte)
& Fieldbus (%2) -

28525070347

7. Create a boot project.

= The |IEC Editor project is saved on the SD memory card of
MOVI-C® CONTROLLER power UHX85A and is still present after restart.

Save the project in the IEC Editor.
Close the IEC Editor.
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5.3

Controller replacement function

Adjusting an existing MOVISUITE® project
Controller replacement function 5

Check to see whether the controller replacement function is enabled to ensure that all
settings are reloaded correctly in the event of a controller hardware replacement.

1. Select [Functions] > [Data management] > [Device replacement] from the menu.

2. To enable the controller replacement function, set the value to "1".

3. Click on the [Update configuration data] button.

4.1.1 Data management

Initialization

Function Setting Value Info

Controller replacement function Activate auto restore for replacement

Axis replacement function
Axis replacement function

MOVIRUN® flexible

Restore axis data sets via controller

Event for starting restore

Device replacement =

Create configuration data for IEC project o i |

Kor1ﬁguratio:sdaten aktualisieren

The configuration data and the axis data sets

are transferred to the MOVI-C®
CONTROLLER.

28535095819

Installation Instructions — Installation and Project Adjustment 45



Overview of version numbers
Engineering software

6 Overview of version numbers

You can assign the available hardware and software components to an SP using the
following tables. The "SP10" column lists only the latest version numbers. The version
numbers of SP9/9.1 are included in SP10.

6.1 Engineering software

Component SP7 SP8 SP9.1 SP10
MOVISUITE® V1.1.1180.0 V1.2.1253.0 v2.0.114.100 v2.1.237.0
IEC Editor 3.5 SP9 patch 5 3.5 SP9 patch 5 3.5 SP12 patch 3 3.5 SP13 patch 1
SEW profile (IEC) SEW 3.5.9.50 (V3) | SEW 3.5.9.50 (V3) | SEW 3.5.12.3 (V5) | SEW 3.5.13.1 (V6)

6.2 IEC libraries

Component SP7 SP8 SP9.1 SP10
SEW loDrvEtherCAT 1.0.200.0 1.1.200.2 1.3.200.0 1.4.200.0
SEW loDrvLogic- 1.0.200.0 1.0.200.0 1.1.200.0 1.3.200.0
alDevicePool

SEW Common

Foldbus Sive Ext. 1.2.200.0 1.2.200.0 1.3.200.0 1.4.200.0
SEW DeviceHandler 1.0.200.0 1.0.202.0 1.1.200.1 1.3.200.0
SEW DeviceHandler 1.0.100.7 1.0.100.7 ; 1.0.100.7
Interfaces

SEW DeviceHandler ] ] 1.1.200.1 1.1.200.1
Interfaces 2

SEW DeviceHandler ) ) ) 1.3.200.0
Interfaces 3

SEW PDO Handling 1.0.200.0 1.0.200.0 1.0.200.0 1.0.200.0

6.3 MOVIKIT® software modules

Component SP7 SP8 SP9.1 SP10
Velocity Drive - - 1.1.200.1 2.0.0.200
Positioning Drive - - - 2.0.0.200
MultiMotion 1.3.201.0 1.5.200.0 2.0.200.0 2.4.13.200
mi‘ﬂgMO“O” Cam- 1.3.201.0 1.5.200.0 2.0.200.0 2.3.28.200
Robotics - - 2.0.200.0 2.3.21.200
MultiAxis Controller - - 2.0.200.0 2.6.20.200
MultiMotion Auxiliary - . 1.0.200.0 1.4.11.200
Velocity
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MOVI-C® CONTROLLER

Component SP7 SP8 SP9.1 SP10
MultiMotion Auxiliary - i 1.0.200.0 1.4.11.200
Positioning

Velocity - - - 1.3.21.200
Positioning - - - 1.3.21.200
6.4 MOVI-C® CONTROLLER

Component SP7 SP8 SP9.1 SP10
power (UHX85A) 02.00 02.01 03.00 04.00
progressive ) _

(UHXB5A) 02.00 03.00
advanced (UHX45A) - 01.00 02.00 03.00
standard (UHX25A) - 01.00 02.00 03.00
6.5 MOVIDRIVE® modular

Component SP7 SP8 SP9.1 SP10
MDA (single-axis 02.03 02.10 03.00 04.00
module)

MDA-CIA402 - i 03.00 04.00
(single-axis module)

MDD (double-axis 02.03 02.10 03.00 04.00
module)

MDD-CIA402

(double-axis module) ) ) 03.00 04.00
6.6 MOVIDRIVE® system

Component SP7 SP8 SP9.1 SP10
MDX 02.03 02.10 03.00 04.00
MDX-CIA402 - - 03.00 04.00
6.7  MOVIDRIVE® technology

Component SP7 SP8 SP9.1 SP10
MDX_T - - - 04.00
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MOVI-C® decentralized drive electronics

6.8 MOVI-C® decentralized drive electronics

Component SP7 SP8 SP9.1 SP10
DFC - - 03.10 04.00
DFC-CiA402 - - 03.10 04.00
DSI - - 03.10 04.00
MOVISAFE®

CSB51A safety card - - - 02.05
6.9 MOVISAFE® safety cards

Component SP7 SP8 SP9.1 SP10
CSS21A - 01.05 01.05 02.05
CSB21A - 01.05 01.05 02.05
CSS31A - 01.05 01.05 02.05
CSB31A - 01.05 01.05 02.05
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